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About this Manual 

This manual describes MAXSURF Resistance, a program used to predict the resistance 
of hull designs. The manual is organised into the following chapters. 
 
Chapter 1 Introduction 
Contains a description of MAXSURF Resistance, its theoretical fundamentals and its 
resistance prediction algorithms. 
 
Chapter 2 Using MAXSURF Resistance 
Explains how to use MAXSURF Resistance’s analysis routines. 
 
Chapter 3 MAXSURF Resistance Reference 
Gives details of each of MAXSURF Resistance’s menu commands. 
 
Chapter 4 Theoretical Reference 
Lists abbreviations and terms used in MAXSURF Resistance and contains a 
bibliography. 
 
Users of the demonstration version of MAXSURF Resistance should refer to Appendix 
A Demonstration Version which describes the limitations imposed on the demonstration 
version.
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Chapter 1 Introduction 

MAXSURF Resistance provides a means of predicting the resistance of a ship hull. 
MAXSURF designs may be read in and automatically measured to obtain the required 
parameters, or the parameters may be typed by hand without the need for an existing 
MAXSURF design file. If the overall efficiency of the propulsion installation is known, 
or may be estimated, the power requirements of the design may be predicted. 
 
Given the data required for the resistance prediction algorithms selected for analysis, 
MAXSURF Resistance will calculate the hull resistance at a range of speeds and will 
give results in graphical and tabular formats. These results may be copied to a 
spreadsheet or word processor for further analysis and/or formatting. 
 
MAXSURF Resistance supports resistance prediction calculations for a wide range of 
monohulls and multihulls. 
 
Many different approaches exist to predict the resistance of a vessel. MAXSURF 
Resistance implements several different resistance prediction algorithms, each 
applicable to various families of hull shapes. For example, some of the algorithms are 
useful for estimating the resistance of planing hulls, while others are useful for 
estimating the resistance of sailing boat hulls.  
 
Besides resistance prediction calculations, MAXSURF Resistance can also be used to 
calculate the wave pattern generated by the vessel for a given velocity. 
 
It should be emphasised that resistance prediction is not an exact science and that the 
algorithms implemented in this program, while they are useful for estimating the 
resistance of a hull, may not provide exact results. 

Coordinate System 

All Modules: Body plan, view from behind (stbd side of vessel on right-hand side of 
screen) 
All Modules with the exception of Stability:Plan view from bottom (stbd side of vessel 
on upper half of screen); Stability has the Paln view from top (stbd side of vessel on 
lower half of screen) 
All Modules:Profile view from stbd (bow on right-hand side of screen) 

MAXSURF Modeler 

 

Longitudinal: +ve forward  -ve aft 

Transverse: +ve stbd -ve port 

Vertical: +ve up  -ve down 
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The zero-point can be defined at any location in the model 

Resistance Calculations Fundamentals 

MAXSURF Resistance is essentially a resistance prediction program. A number of 
regression-based methods and one analytical method can be used to predict the 
resistance of the hull form. 
 
It is normal naval architecture practice to break down the resistance into components 
which scale according to different laws. MAXSURF Resistance can calculate the 
resistance components in coefficient form. However, since different methods use 
different formulations, not all the resistance components may be available. 
 
Total resistance is normally broken down into a Froude number dependent component – 
wave resistance (residuary resistance) and a Reynolds number dependent component – 
viscous resistance (friction resistance). 
 
The bracketed names give an alternative breakdown:  

Total resistance = Wave + Viscous = Residuary + Friction 

Typically the friction resistance is predicted using the ITTC’57 ship-model correlation 
line or some similar formulation. 
 
The viscous resistance includes a form effect applied to the friction resistance thus: 

Viscous resistance = (1 + k) Friction resistance 

, where (1 + k) is the form factor. 
 

Where possible, MAXSURF Resistance calculates all the components of resistance and 
these may be plotted and tabulated separately.  
 
In some cases the regression method predicts residuary resistance and no form factor. In 
these cases, it is not possible to calculate the wave resistance. 

Data Input Options 

In MAXSURF Resistance there are two ways to specify the input data that is used in the 
resistance algorithms:  

 Manually specify the input data* 

 Read the input data from a MAXSURF design and automatically measure the 

surface shape 

 
A combination of the two is also possible: read in and measure a MAXSURF design file 
and manually override the measured data. In any case, it is always advisable to check the 
automatic measurements of half angle of entrance, deadrise, chine type etc. as these can 
be difficult for MAXSURF Resistance to determine automatically. 
 
Note also that the measured dimensions will take into account any skin thickness which 
has been added to the surfaces in the MAXSURF design. Deducted thickness will not be 
adjusted. 
 
* = For the slender body method a mesh on the MAXSURF surface will be calculated which is 
then used to calculate the resistance. This means that, except for the wetted surface area, it is not 
possible to enter or edit the input data manually. 
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Prediction methods 

MAXSURF Resistance provides different algorithms for estimating hull resistance. 
These are divided in different groups dependent on the type of hull.  

 Methods for Planing Hulls 

 Methods for Displacement Ships 

 Methods Applicable To Yachts 

 Analytical Method 

 

Also see: Appendix B Applicability on page 55 for information whether a method may 
be applicable for a particular design. 

Methods for Planing Hulls 

Savitsky (Pre-planing) 

This algorithm is useful for estimating the resistance of a planing hull before it gets 
‘onto the plane’; i.e. its pre-planing resistance.  

Savitsky (Planing) 

Used for estimating the resistance of planing hulls when in the planing speed regime. 

Blount and Fox (Planing) 

Used for estimating the resistance of planing hulls when in the planing speed regime.  
The algorithm is based on the Savitsky planing method with improvements to the 
algorithm at “hump speed”, the speed at which the vessel just begins to plane.  The 
method is considered superior to the Savitsky planning method for vessels that have 
varying deadrise angles in the afterbody, or have a varying beam in the afterbody (i.e. 
not prismatic). 

Lahtiharju 

Used for estimating the resistance of planing hulls when in the planing speed regime. 

Wyman 

A universal formulation used for calculating the resistance of hull forms in both planing 
and displacement modes.   The original method as set out by Wyman results in an 
Engine Power being calculated.  As such, for MAXSURF Resistance to accurately 
predict the hull resistance, an overall efficiency must be added in the Efficiency dialog.   
The overall efficiency accounts for losses between the power developed at the engine 
(Brake Power) and the Effective Power (hull resistance).  
 
From “The Masthead” issue of June 2008 
http://www.westlawn.edu/news/WestlawnMasthead06_June08.pdf: 
“The Wyman speed formula assumes the hull is the correct type and of normal form for 
the intended use.  This includes proper location of the longitudinal centre of gravity and 
buoyancy and a prismatic coefficient in the suitable range.  The formula also assumes 
that the running gear (propeller, reduction gear, shaft, strut, rudder) are properly sized 
and matched for best performance.  There are many common variants of hulls and 
propulsion packages, however, and the following adjustments can be used to further 
refine the results: 
 
Round bilge planing hulls(over SL ratio 2.9):   reduce speed by 6%  
Deep vee planing hulls(deadrise midships aft >19 degrees): reduce speed by 3 % 
Low-deadrise planing hulls(deadrise midships aft < 8 degrees): increase speed by 4% 

http://www.westlawn.edu/news/WestlawnMasthead06_June08.pdf
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Outboard and stern drive boats:     increase speed by 5% 
Displacement full-keel sailboats:     reduce speed by 2%
  
SL=speed length ratio=velocity/sqrt(LWL), where velocity is in knots and LWL in ft. 
 
These effects can be added in a single design to create and net increase/reduction in 
speed.” 
 
It is left to the MAXSURF Resistance user to decide whether any of the above criteria 
apply to their design and implement accordingly. 

Methods for Displacement Ships 

Wyman 

The Wyman method can also be applied to displacement vessels. 

Holtrop 

This algorithm is designed for predicting the resistance of tankers, general cargo ships, 
fishing vessels, tugs, container ships and frigates. 

Compton 

This algorithm is designed for resistance prediction of typical coastal patrol, training or 
recreational powerboat type hull forms with transom sterns operating in the 
displacement and semi-planing regimes. 

Fung 

This algorithm is applicable for resistance prediction of displacement ships with 
transom stern hull forms (generally used for larger vessels than Compton). The 
regression is based on data from tests on 739 models at the David Taylor model basin 
and consists over 10 000 data points, Fung and Leibman (1995). 

van Oortmerssen 

Useful for estimating the resistance of small ships such as trawlers and tugs. 

Series 60 

Used for estimating the resistance of single screw cargo ships. 

Korean Register of Shipping (KR) Barge 

The method is based on the resistance prediction algorithm in “Rules for the Towing 
Survey of Barges and Tugboats” 2010 issued by Korean Register of Shipping and is 
suitable for box shaped vessels (e.g. barges) operating in displacement mode.  

Note 

If air resistance parameters are added in the input table, the applications air 
resistance calculation method is used NOT the KR air resistance method. 

Methods Applicable To Yachts 

Delft Series I, II and III 

Sailing yacht resistance prediction, using the regression based on either Gerritsma et al 
(1991) or Gerritsma et al (1992). 
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Analytical Method 

Slender body method 

A slender body method, based on the work of Tuck et al (1999) and Couser et al (1996) 
is available in MAXSURF Resistance. This method uses a Michell (1898) based 
approach to compute the wave resistance of a port/starboard symmetrical monohull.  
 
This method may be applied to many different hullforms including multihulls. However 
the individual hulls should be slender* and should be symmetrical about their local 
centreline. Planing forces are neglected in the slender body method which limits speed 
range applicability for this method. In general, sensible results can be obtained for a 
wide range of mono- and multihull vessels operating at normal Froude numbers. 
 
This method predicts only the wave pattern resistance component. To calculate the total 
resistance, MAXSURF Resistance calculates and adds the viscous resistance component 
using the ITTC’57 friction coefficient calculation method and the specified form factor. 
 
See Using the slender Body Method on page 21. 
 
* = have narrow beam compared to their length. 

Hull Parameter Validation 

MAXSURF Resistance will check that the entered data is within the valid ranges for the 
selected methods. If the values are okay they will be displayed in black, if they are too 
low they will be displayed in red with the words (low), and if they are too high they will 
be displayed in orange with the word (high). 
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MAXSURF Resistance will still attempt to calculate the hull resistance if the data is out 
of range, but these results should be treated with caution since the accuracy of the 
method may be compromised if parameters are outside the valid range. 
 
Because of the difficulty of accurately determining some measurements from the surface 
model, it is important to verify the following measurements: 

 1/2 angle of entrance 

 Bulb transverse area 

 Bulb height from keel 

 Deadrise at 50% LWL 

 Chine type: hard chine or round bilge 

 
Also see: Data Validation on page 17 for more information on data validation 
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Chapter 2 Using MAXSURF Resistance 

You have been introduced to the way in which MAXSURF Resistance works and can 
now go on to learn in detail how to use MAXSURF Resistance by following the 
example outlined in this chapter. 
 
The example uses a simple planing hull form whose data are supplied in a MAXSURF 
Resistance file called ‘MAXSURF ResistanceExample.hsd’; these are measured from 
the MAXSURF design file ‘MAXSURF ResistanceExample.msd’. 
 
The example goes through the steps needed to predict the resistance of the hull. 

 Getting Started 

 Taking Measurements from a MAXSURF design 

 Opening a Data File 

 Entering Data 

 Calculating Resistance 

Getting Started 

Start up the program by double clicking on the program icon or selecting MAXSURF 
Resistance from the MAXSURF menu under the Start menu. MAXSURF Resistance 
will start up and display the following windows: 

 

 

Perspective  A perspective view of the hull being analysed. 

Plan  A plan view of the hull, looking from below. 
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Starboard above the centreline.  

Profile  A profile view of the hull, looking from 
starboard with the bow to the right.  

Body Plan  A body plan view of the hull, looking forward 
from the stern. 

Data The input data to be used for the analysis. This 
data may be measured from a MAXSURF 
design or typed manually. 

Graph A graph of the hull’s predicted power or 
resistance vs. speed. 

Results A numerical display of the resistance and 
power prediction results, in a format useful for 
copying to a spreadsheet. 

 

Taking Measurements from a MAXSURF design 

MAXSURF Resistance may read and measure a MAXSURF design file directly. 
Because MAXSURF Resistance uses the same method as Hydromax to determine the 
hydrostatic properties of the design, the same rules and limitations about closed sections 
apply. See the Hydromax manual for more information on how to prepare a MAXSURF 
model before loading it into other applications of the MAXSURF suite. 
 
To load a design, select Open Design from the File menu. When the design is loaded in, 
MAXSURF Resistance will automatically calculate the hull’s hydrostatic characteristics 
using 200 sections. 
 
At this point it is a good idea to check that the sections have been formed correctly. Do 
so by going to the perspective window and turning on the sections (in the Display | 
Contours dialog). The immersed sections are shown: 

 

The hull is always measured at the DWL, so if you wish to measure the hull at a 
different draft, change the position of the DWL in the Frame of Reference dialog. (Data | 
Frame of Reference). 
 
Once the measurements have been made, they can be edited if you so desire. Because of 
the difficulty of accurately determining some measurements from the surface model, it is 
important to verify the following measurements: 
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 1/2 angle of entrance 

 Bulb transverse area 

 Bulb height from keel 

 Deadrise at 50% LWL 

 Chine type: hard chine or round bilge 

 

Opening a Data File 

Choose Open Measurement Data from the File menu. Open the file titled ‘MAXSURF 
Resistance Sample_Workboat.hsd’ in the MAXSURF Samples folder. This file contains 
the data for a planing hull form. When it is read in, the Data window will fill with the 
relevant data: 

 

Entering Data 

Note that in the Data window, there are three main columns. The first column contains 
explanations of the data in a particular row, the second column contains the data itself, 
while the third column contains the units for the data in that row. An extra column is 
added for each of the analysis methods used; data required for that method are copied 
into the new column. 
 
Data may be typed into any column apart from the first and third columns. Changing any 
part of the data for a method will change that same piece of data for all methods, i.e. 
changing the length in any column will change the length in every column. 
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Note:  

Input parameters: length; volume; prismatic coefficient and max sectional 
area are related by the formula below. 

  
If data is measured from a design then this data will be consistent. However 
if the data are entered manually, MAXSURF Resistance will recalculate 

these values to maintain consistency. If either length (L), volume () or 
Prismatic Coefficient (CP) are entered, then Max Sectional area (AX) will 
be recalculated. If Am is entered then CP will be recalculated. 

The required data are as follows: 

Length / Lwl 

The length of the hull, measured on the waterline. 

Beam 

The maximum submerged width of the hull. 

Draft 

The maximum submerged depth of the hull. 

Displaced Volume 

The volume of seawater displaced by the hull. 

Wetted Area 

The submerged surface area of the hull.  
 
For the slender body method, the wetted area is used to calculate the Friction and 
Viscous resistance coefficients only (the wave resistance is calculated directly from the 
surface model). 
 
The wetted area is also used to calculate the resistance coefficients displayed in the 
Graph window. 

Prismatic Coefficient 

A measure of the extent to which the submerged volume of a hull fills a prism defined 
by the submerged length, multiplied by the area of the largest transverse section; i.e. 

 

Water plane Area Coefficient 

A measure of the extent to which the area of the water plane fills the rectangle defined 
by the length * beam; i.e. 
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Half Angle of entrance 

The angle measured in the plane of the water plane, between the hull and the centreline.  

LCG from midships 

The distance to the longitudinal centre of gravity, measured from amidships. Note that 
this distance is positive forward. I.e., an LCG 1.5m aft of midships will be entered as -
1.5 .  
 
Note that when MAXSURF Resistance measures a hull, it assumes that the vessel is in 
hydrostatic equilibrium at the DWL and the LCG is assumed to be at the LCB 
(longitudinal centre of buoyancy. 

Transom Area 

The submerged sectional area of the transom, measured when the vessel is at rest. 

Maximum Sectional Area 

The largest submerged sectional area of the hull, measured when the vessel is at rest. 

Bulb Transverse Area 

The transverse sectional area of the bulb (if any) measured on the waterline at the stem. 

Bulb Height from Keel 

The distance from the keel line, to the transverse centre of area of the bulb section on 
the waterline at the stem. 

 

Wetted Area 

The submerged surface area of the hull. 

Draft at FP 

The draft at the fore perpendicular. This value can be left at zero, whereupon 
MAXSURF Resistance will assume it is the same as the value for the ‘draft’ item. 

Deadrise at 50% Lwl 

The deadrise, as measured at midships. 

Frontal Area 

The area of the vessel above the waterline, when viewed from the front. Set to zero to 
ignore wind resistance. 
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Drag Coefficient 

The coefficient of drag for calculation of wind resistance. Expected values would be in 
the range of 0.8 - 1.2. 

Air Density 

The air density, at the appropriate ambient temperature. 1.293 kg/m^3 at 15 deg. C. 

Appendage Area 

The wetted area of appendages, used to calculate appendage drag. Set this to zero to 
ignore appendage resistance. 

Nominal Appendage Length 

This is a nominal length for the appendages which is used to calculate the Reynolds 
Number at which the appendages are operating. This Reynolds Number is used to 
calculate the skin friction drag of the appendages using the ITTC’57 formulation. 
Typically this length would be representative of the rudder (and keel, if applicable) 
chord. 

Appendage Factor 

A factor for estimating the resistance due to the drag on appendages. Expected values 
range from 1.0 to 3.0. 

Correlation Allowance 

A factor used for accounting for variations between model tests and full-scale trials. 
This factor is included only for the analysis methods which used a correlation allowance 
in their original formulation: Savitsky pre-planing; Lahtiharju; Van Oortmerssen and 
Series 60. The Holtrop method includes an implicit correlation allowance which is 

included at all times. The correlation allowance, or CF, may be estimated from the 
ITTC recommended formula: 

 

Where kS is the hull roughness; typically 150x10-6m and L is the waterline length of the 
hull in the same units. 
 
The Correlation Allowance value used for each particular method is listed in the Data 
Window in the “Correlation allow” row. 
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The table below should clarify which methods use which correlation factor: 
 

Savitsky pre-planing None 

Savitsky planing Varies with speed but based on user specified value 

Blount and Fox Varies with speed but based on user specified value 

Wyman None 

Lahtiharju user specified value 

Holtrop constant but calculated by regression method 

Van Oortmeersen  user specified value 

Series60  user specified value 

Delft I,II  None 

Delft III  None 

Compton fixed at 0.0004 

Fung fixed at 0.0005 

KR Barge None 

Slender body  user specified value 

 

Physical Properties of Sea Water 

The values for the density and kinematic viscosity of the water may be edited by the 

user. The ITTC’57 values for salt water (3.5% salinity) at 15C., for density and 
kinematic viscosity are as follows: density 1025.9 kg/m^3 and kinematic viscosity 
1.18831x10-6 m^2/s. 

Calculating Resistance 

Before viewing the results of the resistance calculations, you should validate your data, 
select a resistance prediction method and select a speed range. Once you have chosen 
these options, the results will be automatically displayed in the Results and Graph 
windows. 

 Selecting the Resistance Prediction Methods 

 Data Validation 

 Specifying Speed Range 

 Viewing Results 

Selecting the Resistance Prediction Methods 

To specify which methods to use, choose Methods from the Data menu, or alternatively 

use the - toolbar button. A dialog box will appear which allows you to select the 
resistance prediction methods that you wish to use.  
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As outlined on page 5, different methods are useful for analysing different hull types. 
Since a planing hull is to be analysed, select the methods pertinent to such a design. 
 
Once a method has been selected, a column will appear in the Data window, with spaces 
to enter the data relevant to that method. In general the methods do not use all the data; 
only the data relevant to the analysis method is copied into that column. Unused data 
will contain ‘- -’.  
 
Two additional columns will appear in the Results window for each resistance 
prediction method selected; one for the predicted resistance and one for the power 
required. 
 
For the Slender Body method, a user-specified form factor has to be specified. To use 
the Holtrop and Mennen form factor, give a negative value (e.g. –1.0). The form factor 
is only applied to the slender body method resistance prediction. This method is 
explained in detail in the Using the slender Body Method section starting at page 21. 
 

If the “Use 19th ITTC modified formula for CA” is checked then this method will be 
used. The 19th ITTC proposed a modified formula for CA that splits it into a 

roughness factor DCf and correlation allowance: 

 
- ΔCF is the roughness allowance  

 
where kS indicates the roughness of hull surface. When there is no meas-ured data, the 
standard value of kS=150×10-6 m can be used.  
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- CA is determined from comparison of model and full scale trial results. When using the 
roughness allowance as above, the 19th ITTC recommended using: 

 
 
Also see 

Prediction methods on page 5 for more information on the different methods 
available in MAXSURF Resistance. 
Appendix B Applicability on page 55 to investigate which method is appropriate 
for a particular type of vessel. 

Wind and Appendage Resistance 

Wind and appendage resistance may also be accounted for in the resistance calculation.  
 
Entering the frontal area of the vessel, the drag coefficient and the air density will cause 
air resistance to be included in the analysis. Setting any of these values to zero will 
ignore air resistance. 
 
The frontal area is the above-waterline area of the vessel when viewed from the bow, 
Afrontal. The drag coefficient, Cd, will depend on how ‘streamlined’ the vessel is. A very 
streamlined vessel would have a drag coefficient of less than one, say 0.8, while a less 
streamlined vessel would have a drag coefficient of greater that 1, say 1.2. 
 
The wind resistance is calculated as follows:  

 

Where air is the air density and Vrel. is the relative wind speed. 
 
Entering the wetted area of the appendages, and nominal appendage length (for 
calculation of appendage Reynolds Number), as well as an ‘appendage factor’, will 
cause the resistance of these appendages to be estimated by MAXSURF Resistance.  
 
The wetted area of the appendages, Aappendage, is the total wetted surface of appendages, 
while the appendage factor, fappendage, is an indication of the resistance of the appendages. 
Value for the appendage factor typically vary from 1.0 to 3.0. 
 
The appendage resistance is calculated as follows:  

  

Where water is the water density and Vboat is the vessel speed. The skin friction 
coefficient, Cf, is calculated from the ITTC’57 formula, using the nominal appendage 
length to calculate the Reynolds Number. 

Data Validation 

Measurement data, either measured from a hull or entered by hand will automatically be 
compared with the limits of the chosen speed prediction methods. 
 
In the Data window, measurements that are outside the valid range for a particular 
method will be highlighted in the column for the method in question. Data in red 
indicates that the value is too low, whilst data in orange is too high. 
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Please note that in some cases, the valid range for a particular method may be in terms 
of a ratio or coefficient such as B/T. In such a situation, if the B/T ratio was too high, 
the beam would be highlighted as being too high and the draft would be highlighted as 
being too low. In some cases, this can cause a value such as beam to be both too high 
and too low; this would occur if both B/T and L/B were too high.  
 
Please refer to Appendix B Applicability, section Dimensions on page 56 for details of 
the valid ranges for the different analysis methods. 
 
Also see: Entering Data on page 11 

Specifying Speed Range 

Once the prediction methods have been chosen, the speeds over which the analysis is to 
be carried out need to be set. To do this, 

 choose Speeds from the Data menu, or 

alternatively use the -toolbar button. 
 
A dialog box will appear: 

 

 Enter the minimum speed 

 Enter the maximum speed 

 Click on the OK button 

Viewing Results 

For the regression analysis methods (all methods except analytical), the resistance and 
power are automatically calculated whenever a change is made to the input data. The 
analytical results can only be obtained after solving the analysis, see Using the slender 
Body Method on page 21 for more information.  

Results Table 

A table with the calculation results will be tabulated in the Results window. 

Results Graph 

A graph of the results will appear in the Results Graph window. 
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Clicking on any of the curves in the graph will show the resistance and speed values at 
that point in the bottom left of the Graph window. 
 
Double clicking on the graph will bring up a table with all the graph data points. 
 
The type of graph displayed can be changed by selecting Graph Type from the Display 
menu. 

 

As well as graphs of resistance or power, it is possible to plot the individual resistance 
coefficients.  
 
Alternatively this can be done by selecting the required component from the pull-down 
list in the Graph toolbar: 



Please note that not all methods calculate all the resistance components; many of the 
methods use the residuary + friction approach and hence the wave and viscous 
components cannot be derived. The following table summarises which components are 
calculated by each method.  
 

Method RT RR RW RF RV  RCor RApp RAir θD

Savitsky pre-planing  yes no no no no yes yes yes no 

Savitsky planing  yes yes no yes1 no yes yes yes yes 



Chapter 2 Using MAXSURF Resistance 

Page 20 

Blount and Fox yes yes no yes1 no yes yes yes yes 

Wyman yes yes no yesITTC’57 no no yes yes no 

Lahtiharju  yes no no no no yes yes yes no 

Holtrop  yes yes yes2 yesITTC’57 yes yes3 yes yes no 

Compton  yes yes no yes ITTC’57 no yes yes yes no 

Fung  yes yes no yes ITTC’57 no yes yes yes no 

van Oortmerssen  yes yes no yes ITTC’57 no yes yes yes no 

Series 60  yes yes no yes4 no yes yes yes no 

Delft I, II  yes yes no yes5 no no yes yes no 

Delft III  yes yes no yes5 no no yes yes no 

KR Barge yes yes no yes6 no no yes yes no 

Slender Body  yes yes yes yes ITTC’57 yes7 yes yes yes no 

 
Table notes: 

1: 

The ATTC’47 (Schoenherr) friction line is used, but a modified wetted 

surface area is used: 

2
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2: 
The Holtrop wave resistance also contains the “bulb” and “transom” 
components 

3: 
The Holtrop method includes a regression equation for determining the 
correlation allowance coefficient; this is used rather than the user-specified 
value. 

4: Uses alternative friction line: 
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5: 
Uses ITTC’57 friction line, but Reynolds Number is based on a shorter 
length: 0.7 LPP 

6: 
Rf [ton] = 0.000136 * F1 * A1 * V2 
with F1 : hull surface condition coefficient, 0.8; A1 : surface area below 
waterline [m2]; and V : velocity [kn] 

7: 
If the user specified form factor is negative, the slender body method uses 
the form factor as calculated by the Holtrop method. 

ITTC’57 Uses the ITTC’57 friction line: 
 210 2)(log

075.0
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RT Total resistance; either expressed as: RT = RR + RF + RCor + RApp + RAir  
or RT = RW + RV + RCor + RApp + RAir 

RR Residuary resistance; total hydrodynamic resistance less skin friction 
resistance. Does not include RCor, RApp or RAir 

RW Wave resistance; resistance due to energy input into the generation of free 
surface waves. 

RF Friction resistance; skin friction of equivalent flat plate area, typically uses the 
ITTC’57 ship-model correlation line or Schoenherr friction line. 

RV Viscous resistance; skin friction viscous resistance plus allowance for 3D form 
effects of the hull. Typically by the use of a form factor (1+k). In this case RV = 
(1+k) RF 

RCor Correlation allowance resistance; additional resistance for correlation from 
model to ship scale 

RApp Appendage resistance; resistance of appendages such as rudder, etc. 

RAir Air resistance; wind resistance of above-water hull and superstructure 

θD Running Trim vs Speed. 
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Using the slender Body Method 

This analytical method is based on the so-called slender ship or slender body method. It 
computes the energy in the free surface wave pattern generated by the vessel and hence 
the wave resistance of the vessel. To calculate the total resistance, MAXSURF 
Resistance calculates and adds the viscous resistance component using the ITTC’57 
friction coefficient calculation method and the specified form factor. 
 
The following section explains how to use the slender body method provided in 
MAXSURF Resistance to compute the resistance of both mono- and multihull vessels. 
The information given here also applies to the calculation of the free surface wave 
patterns described later in this manual since they use the same theoretical basis. 
 
In this section:  

 Model Validation 

 Calculating the Slender Body Resistance 

 Slender Body Analysis Geometry 

 Calculating the Form Factor 

Model Validation 

Except for the wetted surface area, the input data for the slender body method is not 
displayed in the input table and can thus neither be validated nor modified by the user. 
To make sure that MAXSURF Resistance interprets the surface model correctly, it is 
recommended to check the slender body mesh.  
 
This can be done by turning on the SB mesh option in the Display menu. The number of 
sections used can be increased for greater accuracy, though this will increase the 
computation time. Particular attention should be paid to the mesh of multihulls and 
vessels with transom sterns. See the following sections for more details. 
 
It is also recommended to read the papers on the slender body method listed in the 
Bibliography on page 50. The following section can be used as a guideline:  
 

The slender body method assumes the vessel to be slender (i.e. high length:beam 
or slenderness ratios). Ideally the slenderness ratio should be as high as possible, 
but in practice, good results can be obtained for slenderness ratios of around 5.0 
to 6.0. If the vessel’s Froude number is reduced, the minimum slenderness ratio to 
which the method is applicable also reduces. The maximum Froude number for 
which sensible results can be obtained depends on the vessel’s slenderness ratio. 
It has been found that, for very slender vessels (slenderness ratios greater than 
7.0), the slender body method may give sensible results for Froude numbers as 
high as 1.0. The slender body method may be applied equally well to round bilge 
and chine hull forms. Hulls with transom sterns are dealt with by automatically 
adding a “virtual appendage”. This method is described in detail in Couser et al 
(1996). 

 
Also see: 

Appendix B Applicability on page 55 

Calculating the Slender Body Resistance 

After making sure that the vessel can be analysed with the slender body method,  
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 Select the Slender Body Method in the Methods dialog from the Display 

Menu 

 Specify the form factor, see below for explanation 

This method is slower than the regression (non-analytical) methods in MAXSURF 
Resistance, and so is not automatically calculated. To calculate the resistance,  

 Select Analysis | Solve resistance analysis or use the solve toolbar button 

. 

This will calculate a mesh on the MAXSURF surface and calculate the resistance.  

Form Factor 

The form factor to be used for the slender body analysis can be specified in the 
Methods dialog. If a form factor of less than zero (negative) is entered, the 
Holtrop and Mennen formulation for form factor will be used. 

Note: 

This method uses the MAXSURF hull surfaces directly, so a full model is 
required and changing the measurement parameters, other than wetted 
surface area, will not affect the results. Wetted surface area is used only to 
compute the friction resistance and the resistance coefficients displayed in 
the Graph window. 

Slender Body Analysis Geometry 

The analysis mesh for the slender body analysis can be displayed by ticking “SB Mesh” 
in the Display menu.  

 

Slender body mesh (orange grid) for MORC sample model 

If the vessel type (monohull, multihull) has been correctly setup in MAXSURF, the 
geometry should be correctly interpreted by MAXSURF Resistance. The mesh is a 
series of sections and waterlines forming a rectangular grid that is symmetrical about the 
hull’s centreline. For multihulls this means that there is one such mesh for each 
individual hull. This mesh is symmetrical about the local hull centreline; for example, a 
catamaran’s slender body mesh consists of one mesh that is symmetrical about the 
demihull centreline and mirrored about the catamaran’s centreline. This means that each 
individual hull must be symmetrical about its own centreline, but the overall model can 
be asymmetrical (e.g. a proa). 
 
If the hull has an immersed transom, an appendage is added to the slender body mesh 
which blends all the waterlines back into the local centreline; this can be seen in the 
image above. See Modelling the Transom on page 24 for more information. 
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Editing the Slender Body Geometry 

In some cases it may be necessary to edit the slender body mesh. This is done by 
selecting “SB Analysis Geometry” from the analysis menu. A dialog is displayed with a 
table containing one row for each mesh group; you need one group for each individual 
hull in the model: 

 

Dialog for definition of slender body groups 

This dialog is the same as that used for definition of the Shipflow groups in Hydrolink. 
Of main interest for MAXSURF Resistance are the following columns: 

Colour: 

The colour the mesh is drawn 

Surfaces: 

The surfaces to be used to calculate the offsets. Double click on the surfaces cell 
to select which surfaces should be used. It is best to choose only the surfaces that 
define the sections, this is especially true for multihulls. When you close the 
surface dialog you will be asked if you want to automatically set the bounding 
box to the selected surfaces. Clicking “Yes” will set the bounding box to the 
rectangular extents of a box containing the selected surfaces. 

  

Selection of the surfaces to be grouped for measuring the slender body mesh 

Num. of contours: 

The number of contours for the mesh; the number of waterlines is chosen 
automatically to match the number of sections. The greater the number of sections 
the better the accuracy of the analysis (but the analysis will also take longer). 
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Trans. origin: 

This is used as the local hull centreline. For monohulls this should be zero, for 
multihulls this should be the local symmetry plane / centreline of the individual 
hull. For example, for a catamaran this is the transverse position of the demihull 
centreline. 

Aft, Fwd, A port, A starb, A top, A bott, F port, F starb, F top, F bott: 

The last 10 columns define a longitudinally prismatic (or tapered) box which 
defines the boundary of the mesh. The definition of the bounding box is similar to 
the way tanks are defined in Hydromax: the Aft and Fwd columns define the 
longitudinal aft and forward extents of the box, the A port, A starb, A top and A 
bott columns define the port, starboard, top and bottom extents of the box at the 
aft plane. The corresponding four columns prefixed with F, can be used to define 
a tapering box with different port, starboard, top and bottom extents on the 
forward plane. 

Open and Save buttons: 

The data in the dialog can be saved and retrieved using the Save and Open buttons 
in the dialog. This can be useful if you have customised the slender body mesh 
definition and want to be able to retrieve it easily. 

 
Further information on this dialog can be found in the Hydrolink manual in the Shipflow 
export section 

Modelling the Transom 

The slender body mesh is created by calculating the hull surface offsets on a regularly 
spaced grid of sections and waterlines. Mesh points which fall off the hull surface are 
given an offset of zero and remain on the hulls centreline. For the slender body theory, 
the mesh must start and finish with waterlines that lie on the centreline, i.e. the bow and 
stern sections must have all points at zero offset. (It is possible to remove this 
requirement for the stern by applying a transom correction). 
 
MAXSURF Resistance deals with transoms in a special manner; the mesh is brought 
back to the centreline plane behind the model by applying a “virtual appendage” which 
is smoothly attached to the transom. This method was found to give good results for 
monohull and catamaran forms with transom sterns (Couser 1996, Couser et al 1998). 

 

 

Mesh layout for the stern of a canoe-bodied hull without transom – Mesh follows hull 
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Mesh layout for a hull with a transom– Artificial closure of mesh behind transom using a smoothly attached 
“virtual appendage” 

The “virtual appendage” can be removed by making the aft extent of the mesh bounding 
box end just after the end of the transom – see below: 

 

With the aft bounding box of the mesh terminating just aft of the transom, the “virtual appendage” is removed 

Note: 

The virtual appendage is not included in the wetted surface area 
calculation. It is only used to artificially close off the numerical model to 
calculate the wave resistance. 
 
Note that removing the virtual appendage will affect the free-surface wave 
pattern and wave resistance calculation. The calculated free surface wave 
pattern with and without the virtual appendage can be used to judge 
whether this appendage should be added or not. From the work of Couser 
1996, Couser et all 1998, it can be seen that adding the virtual appendage 
gives good results for monohulls and multihulls with transoms sterns. 

Multihull Mesh Examples  

MAXSURF Resistance is able to compute the resistance of multihulls (catamarans, 
trimarans, pentamarans etc.) using the theoretical slender body method. There is no limit 
to the number and position of the individual hulls, but each hull must have transverse 
symmetry about its local centreline plane. To use this capability, it is important that the 
vessel type (see the MAXSURF manual) is set up correctly. There should be one mesh 
group (one row in the SB Geometry dialog, see page 23) for each individual hull of the 
model. Some example mesh definitions for different types of multihulls are shown 
below: 
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Catamaran 

If the vessel type is correctly defined in MAXSURF, MAXSURF Resistance will 
automatically generate a symmetrical mesh that is centred on the local demihull 
centreline. 

 

Vessel Type dialog setup in MAXSURF for a catamaran 

 

Catamaran has a single mesh mirrored about the vessel centreline.  
The mesh is symmetrical about the local demihull centreline 
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Trimaran 

 

Vessel Type dialog setup in MAXSURF for a trimaran 

Two meshes will be required, one of the main hull and one for the outer hull (referred to 
as “ama”). If the vessel type is correctly defined in MAXSURF, these two meshes will 
be automatically defined. However it may be necessary to change the longitudinal 
extents of the meshes, especially if the hulls have transoms. It may also be necessary to 
select which surfaces define the main hull and which define the ama. The simplest way 
to do this is to double click in the Surfaces cell, select only the surfaces required for the 
specific mesh and then click OK. Then click Yes to set the bounding box extents to the 
selected surfaces. 

 

Incorrect: Default grid for Trimaran sample. Ama grid 
extends too far aft and the virtual appendage shape 

shows a rapid transition aft of the ama transom 

 

Correct: Ama grid has been set to use only the ama 
surfaces and the bounding box has been set to those 

surfaces: correct transom closure on ama 
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Correct Mesh definition for trimaran sample above, Aft extent for Mainhull is –77.17, but only –64.88 for Ama 

These files may be found in: Program files\MAXSURF\Sample 
Designs\Multihulls\Trimaran\Trimaran.msd 
The mesh definition file is: TrimaranHSmeshDefn.hyd 
 

Proa 

It is possible to model asymmetrical vessels provided that each individual hull is 
symmetrical about its own centreline. In the example below, the main hull is a 
symmetrical surface, whilst the outrigger (referred to as ama) is made up of two surfaces 
that are:  

 asymmetrical about the vessel’s centreline (there is no ama on the other side of 

the centreline) 

 mirrored about the ama centreline 

 
Two mesh groups are required. The one for the main hull is defined as if the main hull 
were a monohull. For the ama, the transverse origin is specified as the transverse offset 
of the local centreline of the ama hull, and only the starboard side of the ama hull is 
used. 

 

Slender body mesh definition for main hull and ama 
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Wave pattern calculated for proa model 

Calculating the Form Factor 

MAXSURF Resistance can automatically calculate the form factor that is used during 
the slender body analysis. You can chose to specify the form factor directly, or use 
MAXSURF Resistance’s Holtrop for Monohulls or the Molland algorithm for 
catamarans. 
 

 

The Molland et al. method uses the demihull slenderness 

ratio, , to determine the form factor according to 
the following equation: 

 
 
Note that this expression is for the form factor, 

)1( k , of the complete catamaran including viscous 

interaction effects between the demihulls. 
 
For more information please refer to the Bibliography on page 50. 

Calculating Free Surface Wave Pattern 

MAXSURF Resistance may be used to calculate the wave pattern generated by a vessel. 
The wave pattern is calculated using a Michell / Slender Body type approach, i.e. the 
same method as the slender body resistance prediction; see Analytical Method. This free 
surface wave pattern calculation ignores the effects of viscosity and wave breaking. 
 
The wave pattern is calculated on a grid specified in the Analysis | Free Surface 
Calculation Parameters dialog. 
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Free surface speed 

The Speed field in the Free Surface Calculation Parameters dialog allows you to 
specify the vessel speed at which you wish to calculate the wave pattern. This can 
either be specified directly as a speed or as a Froude Number.  

Free surface grid area 

The area over which the free surface is to be calculated is specified in terms of 
vessel lengths. You can specify the number of vessel lengths forward and aft of 
the vessel as well as to port and to starboard. In addition, you can also specify the 
number of grid points to be used in the transverse and longitudinal directions. If 
the vessel is symmetrical, you can specify a symmetrical free surface, so that only 
the starboard side of the free surface is calculated and then simply mirrored about 
the centreline to produce the port side.  
 
If you have an asymmetric model like the proa described in the previous section. 
You cannot select the Mirror option as the wave pattern will have port and 
starboard asymmetry. 

Free surface integration precision 

The integration precision option refers to the accuracy of free surface calculation; 
the higher the number, the greater the accuracy (note that the integration method 
requires that this number be odd and it will be adjusted if required). The 
calculation can be quite slow (press and hold the Escape ‘Esc’ key to abort) and is 
greatly affected by the number of grid points and the integration precision. For 3D 
rendered views, acceptable results can be achieved with relatively low settings, 
however to obtain smooth contour plots a very large number (of the order of 
30,000) may be required. These values also depend on the Froude Number. 

Free surface wave height vertical exaggeration 

You can exaggerate the displayed wave pattern by changing the Vertical 
exaggeration. 
 
After the wave pattern has been calculated, this exaggeration factor can be 
changed without having to recalculate the wave pattern. To do this, edit the value 
and close the dialog with Cancel instead of OK. This will apply the amplification 
without recalculating the free surface. 
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Wave Pattern Display 

The wave pattern may be displayed in all view windows in MAXSURF Resistance in 
various ways. The display options are dependent on the frontmost view window and can 
be selected from the Display window.  

2D view 

In the 2D view windows, i.e. Plan, Profile or Body Plan, you can display the 

 Wave Grid 

 Wave Contours, isometric elevation lines 

 
The image below is an example of a monohull isometric elevation contours in plan view. 
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3D view 

In the 3D view Perspective window you have the option of displaying the free 
surface wave pattern with- and without rendering (Display | Render).  
 
Also you can additionally display the  

 Solid Wave Render, only when Render is turned on 

 

 

Rendering of waves and wave grid with ocean colour 

 

Rendering of wave grid only 

 

False-colour rendering of wave contour.  Ocean colour disabled 
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Saving and Loading Wave Patterns 

Because the calculation of wave patterns can be quite time consuming, these can be 
saved and reloaded from the File menu. The file can be saved in two formats: Firstly, a 
relatively simple text format which allows users to load the data into other application 
for producing (for example) wave cuts; the data is tab delimited to facilitate loading into 
MS Excel. Alternatively the file may be saved as a DXF mesh file – which can be 
rendered in Rhino3D for example. 

  

Wave pattern text file format 

The file format is as follows: 
 
The first number is the file format version (1). The second indicates if it should be 
mirrored or not (0 not mirrored; 1 mirrored). 
 
The next two lines give the number of points in the longitudinal and transverse 
direction respectively. 
 
The rest of the data is based on a grid (this should be apparent when you view the 
data in Excel). The first line is the list of transverse positions for the grid (from 
port to starboard). The subsequent lines then give the longitudinal position in the 
first column (starting from aft moving forward) followed by the free surface 
elevations for the free surface grid points. All measurements are relative to the 
MAXSURF model zero point and are in the current length units.  
 
A transverse cut through the wave pattern can be made by looking at a single row 
and a longitudinal cut can be made by looking at a single column. 
 
The two final lines at the bottom of the table give details of the model and speed 
used to calculate the wave pattern. 
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Accuracy of Wave Pattern Calculations 

Several features of the numerical methods required to compute the wave pattern cause it 
to be less accurate than the calculation of the wave resistance. Not least of these, is the 
fact that the computation for the wave resistance is equivalent to computing the wave 
pattern at one single grid point on the free surface and thus significantly less 
computational intensive. Also, in the case of the resistance computation, the functions 
that must be integrated are smoother and can thus be integrated with more accuracy. The 
“Integration precision” option in the Free Surface Calculation Parameters dialog 
controls the precision with which the main integration is performed and this will affect 
the smoothness and accuracy of the calculated wave pattern. For accurate results, this 
should be above 50,000 and in most cases it is advisable to use 100,000. However, this 
can take a few 10s of minutes on a 3GHz Pentium4, depending on the number of grid 
points being evaluated. 
 
Thus the wave pattern calculation is generally to be used for presentation purposes or 
where an indication of the likely wave pattern is required. This is particularly true closer 
to the vessel since the accuracy of the wave pattern will be higher several vessel lengths 
aft of the vessel. 

Power prediction in MAXSURF Resistance 

There are various different powers which may be of interest to the naval architect: 

Effective horsepower (ehp) 

Power to push the naked hull through the water at a given speed. This is the 
product of the naked hull resistance and the ship velocity. The corresponding 
value including hull appendages is called ehp’. Where: 
 
1 / appendage coefficient = ehp / ehp’ 
 

Thrust horsepower (thp) 

This is the thrust horsepower developed by the propulsors. And in the case of a 
propeller is given by the product of the propeller thrust, T, and the inflow velocity 
into the propeller V1 
 
The ratio of the ehp to thp is known as the hull efficiency and for most vessels is 
close to unity. It can be expressed as a Taylor wake factor (or fraction) and 
augment of resistance or Froude wake factor and thrust deduction factor 
 
Hull efficiency ηH = ehp’ / thp 
 

Delivered horsepower (dhp) 

This is the power delivered to the propulsors when propelling the ship. Relate to 
this is dhp’ which is when the propulsor is operating in open water. 
 
Propeller open water efficiency ηo = thp / dhp’; for typical propellors thi s might 
be of the order of 50% – 70% 
 
Relative rotative efficiency ηR = dhp’ / dhp 
 

Shaft horsepower (shp) 

This is the power needed to propel the complete ship. When compared with the 
delivered power, this depends on the losses in the transmission system: 
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Shaft transmission efficiency = dhp / shp 
 

Propulsive coefficient (PC) 

The ratio of the effective horsepower to the shaft horsepower is the propulsive 
coefficient 
 
PC = ηH ηo ηR Shaft transmission efficiency / Appendage coefficient  
 

Quasi-propulsive coefficient (QPC) 

Ignoring the transmission losses, thus the ratio of the effective horsepower to the 
delivered hosepower is the quasi-propulsive coefficient 
 
QPC = ηH ηo ηR / Appendage coefficient 

 
The power calculation given by MAXSURF Resistance is simply the product of 
Resistance, velocity and efficiency. The efficiency is specified by the user and the same 
efficiency is used to calculate the power over the whole speed range. 

, where 

V is the ship velocity;  

, the efficiency 
R, the resistance. 

 
The efficiency you should use depends on what power you are looking at. For example 
if you want the effective power the efficiency would be unity; if you wanted the shaft 
power the efficiency would be the propulsive coefficient (PC) which accounts for 
propulsor efficiency, hull efficiency, relative rotative efficiency, appendage coefficient 
and the shaft transmission losses  there are many sources that document these 
efficiencies and how to compute them. 
 
The power calculation uses the efficiency specified by the user; the same efficiency is 
used at all speeds. The efficiency may be changed by selecting Efficiency from the Data 
menu. The efficiency is entered as a percentage. 
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Chapter 3 MAXSURF Resistance Reference 

This chapter summarises the overall structure of windows, toolbars and menu 
commands used in MAXSURF Resistance, including a glossary and references.  

 Windows 

 Toolbars 

 Menus 

Windows 

MAXSURF Resistance uses a range of windows. 

View Windows 

MAXSURF Resistance has four view windows which are exactly the same as the 
windows in MAXSURF. 

Data Window 

Displays the input data that is used for the selected methods. The input data may be 
measured from a MAXSURF design or typed manually. 

Graph Window 

Displays a graph of the hull’s predicted power or resistance vs. speed and Froude 
number. See Results Graph on page 18. 

Results Window 

A numerical display of the resistance and power prediction results, in a format useful for 
copying to a spreadsheet. See the Results Table on page 18. 

Toolbars 

Users of the Windows version of MAXSURF Resistance can use the icons on the 
toolbars to speed up access to some commonly used commands. You can hold your 
mouse over an icon to reveal a pop-up tool tip of what the icon does. 

File Toolbar 

 

The File toolbar contains icons which execute the following commands: 
New Data – Open Design – Save Design | Cut - Copy - Paste | Print Preview 

View Toolbar 

 

The View toolbar contains icons which execute the following commands: 
Zoom – Shrink – Pan – Home View – Rotate – Assembly window.  
 
The Rotate command is only available in the Perspective window. The Assembly 
window is not available in MAXSURF Resistance. 
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Contours Toolbar 

 

The Contours toolbar contains icons which facilitate the display of surface contours: 
Sections – Buttocks – Datum WL – Waterlines – Edges 

Analysis Toolbar 

 

The Analysis toolbar is used to access the most commonly used analysis commands.  
Analysis methods – Speed range | Solve (for slender body method only) – Calculate free 
surface 

Window Toolbar 

 

The Window toolbar contains icons which make the corresponding window come to the 
front: 
Perspective – Plan – Profile – Body Plan – Data window – Results window – Graph 
window 

Render Toolbar 

 

The Render toolbar contains icons for rendering the MAXSURF model in the 
perspective view: 
Render on/off – Light 1 – Light 2 – Light 3 – Light 4 – Light properties 

Menus 

MAXSURF Resistance uses the standard set of Windows menu commands for File, Edit 
and Window operations. 

 File Menu 

 Edit Menu 

 View Menu 

 Analysis Menu 

 Display Menu 

 Data Menu 

 Windows Menu 

 Error! Reference source not found. 

 

File Menu 

The File menu contains commands for opening and saving files, exporting data and 
printing. 

Open Design 

Selecting Open will open a MAXSURF file for measuring. 
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Close Design 

Selecting Close will close the MAXSURF file. Note that, since you cannot edit the 
MAXSURF design in MAXSURF Resistance, you cannot save the MAXSURF file. 

New Measurement Data 

Selecting New will clear the current set of measurement data in anticipation of a new 
set. If the current data has been changed since it was last saved, a dialog box will appear 
asking whether you wish to save the current set of data. If you select Yes, the current set 
of data will be saved to the disk before the Data window is cleared. 

Open Measurement Data 

Opens a data file previously saved from MAXSURF Resistance. 

Close Measurement Data 

Select Close Measurement Data when you wish to finish with the current set of data. 
Before closing, a dialog box will appear asking whether you wish to save the current set 
of data. If you select Yes, the current set of data will be saved to the disk. 

Save Measurement Data 

Saves the measurement data in a file for later recall. If the data was changed after 
selecting New Measurement Data, MAXSURF Resistance will prompt the user to 
specify a name for the new file. 

Save Measurement Data As 

Saves the current MAXSURF Resistance data file with a different (user-specified) 
name. 

Open Free Surface 

If a free surface wave pattern has been calculated and saved previously, it may be 
reopened with this command to save having to recalculate it. 

Save Free Surface As 

If a free surface wave pattern has been calculated it may be saved in a text file or DXF 
mesh file. It can then be reopened at a later date. The free surface file is a simple text 
file and can be imported into Excel or other applications for plotting wave cuts etc. See 
Saving and Loading Wave Patterns on page 33. 

Import nuShallo mesh. 

Import a nuShallo mesh file directly for analysis in Resistance. 

Export Bitmap Image. 

As in the other MAXSURF applications, this command may be used to export a bitmap 
file of the rendered perspective view. 

Export Wavefront mesh. 

Export the rendered mesh as a Wavefront mesh file for use in 3rd party rendering 
software. 

Page Setup 

The Page Setup dialog allows you to change page size and orientation for printing.  

Print 

Choosing the Print function prints out the contents of the foremost MAXSURF 
Resistance window. See the MAXSURF manual for more information. 
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Exit  

Exit will close down MAXSURF Resistance. If MAXSURF Resistance has a set of data 
open that has not been saved to disk, you will be asked whether you wish it to be saved. 

Edit Menu 

The Edit menu contains commands for copying and pasting data and working in tables. 

Undo 

Undo will undo the last change made in the Data window. 

Cut   

Cut cannot be used in MAXSURF Resistance. 

Copy 

You can copy data from the MAXSURF Resistance windows. In the Data and Results 
windows highlight the columns and rows you wish to copy and select Copy or type 
Ctrl+C.  
 
To copy the row and column titles press Shift whilst selecting Copy (Ctrl+Shft+C). This 
data may then be pasted into other applications such as spreadsheets and word 
processors. 

Paste 

You may paste data from spreadsheets, etc. into the Data window. 

View Menu 

The View menu contains commands that control the appearance of the display in the 
frontmost windows. 

Zoom 

The Zoom function allows you to examine the contents of the frontmost view window in 
detail by enlarging any particular area to fill the screen. 

Shrink 

Choosing Shrink will reduce the size of the displayed image in the frontmost view 
window by a factor of two.  

Pan   

Choosing Pan allows you to move the image around within the frontmost view window.  

Home View 

Choosing Home View will set the image back to its Home View size. MAXSURF 
Resistance starts up with default Home View settings for each of the view windows. 
However, the Home View may be set at any time by choosing the Set Home View 
function. 

Set Home View 

Choosing Set Home View allows you to set the Home View in the frontmost view 
window. 
 
To set the Home View, use Zoom, Shrink, and Pan to arrange the view as you require, 
then select Set Home View from the View menu. 
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Rotate 

Activates the Rotate command, which is a virtual trackball which lets you freely rotate a 
design in the Perspective view window. 

Colours and Lines 

The Colour function allows you to set the colours used in the power/resistance graph or 
the colours of the contours used to display the MAXSURF design in the view windows. 
 
MAXSURF Resistance will display a list of display items that can be modified. These 
display items are dependent on the frontmost window. 

Font  

Font allows you to set the size and style of text used in the frontmost window. 

Toolbars 

Allows you to select which Toolbars are visible, see Toolbars on page 37 for further 
details. 

Status Bar 

Makes the Status Bar at the bottom of the screen visible. This Status Bar displays 
information about the current state of what is being viewed in the window as well as 
short descriptions of the functions of some commands as your mouse passes over them 
and indicates the state of some control keys. 

Analysis Menu 

The Display menu contains commands for setting the analysis parameters and solving 
the analysis. 

Methods 

Selecting Methods will bring up a dialog box which allows the user to select which 
prediction methods will be used. The methods chosen will be saved together with its 
required input data. 

Speeds 

Selecting Speeds will bring up a dialog box which allows you to select the speed range 
over which the analysis will be performed. 

Efficiency 

Selecting Efficiency will display a dialog box which allows the user to specify the 

efficiency, , used to calculate the ship’s power, P, from the resistance, R: 

, where 

V is the ship velocity 
 
The efficiency is entered as a percentage. 

Measure Hull 

Selecting Measure Hull will cause MAXSURF Resistance to calculate the data it 
requires from the MAXSURF file currently loaded. The user will be asked to select the 
surfaces to be included in the measurement process. For designs such as yacht hulls, it is 
advisable not to include the surfaces, which define the appendages, such as the rudder 
and keel. 
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If this option is chosen, any data already input by the user will be over written by the 
measured values. 

SB Analysis Geometry 

Used to set up the surfaces and bounding box to be used to calculate the slender body 
mesh. You can also specify the number of sections to be used and the colour of the 
drawn mesh. 

Barge Analysis Geometry 

Used to define the category of barge bow shape to be used. 

Solve Resistance Analysis 

All analysis methods other than the slender body method are computed as soon as any of 
the analysis parameters are changed. However, the computation time for the analytical 
slender body method is considerably slower; for this method, you must tell MAXSURF 
Resistance to perform the analysis by selecting the Solve Resistance Analysis command. 

Calculate Free Surface 

Calculates the wave pattern generated by the vessel for the specified speed using the 
slender body method. 

Display Menu 

The Display menu contains commands for changing the display. 

Graph Type 

Allows the user to select whether a Power vs. Speed; Resistance vs. Speed or Resistance 
Coefficient vs. Speed graph is shown in the Results Graph window. 
 
Note that in the case of the Resistance Coefficient vs. Speed graph, the y-axis is 
multiplied by a factor of 1000. 

Contours 

The contours command lets you select which contours are displayed in the design views. 

SB Mesh 

The SB Mesh command in the Display menu display the hull surface mesh used for the 
slender body method. The mesh parameters may be modified with the SB Analysis 
Geometry command in the Analysis menu. See the Wave Pattern Display on page 31 for 
more information.  

Wave Grid 

Displays a rectangular wire-frame, grid connecting the points at which the wave pattern 
elevation has been calculated 

Wave Contours 

Displays isometric wave elevation contours for the computed free surface. In rendered 
mode a false-colour rendering is used. 

Wave Solid Render 

In rendered mode, selecting Wave Solid Render will shade the rendered free surface. 
For printing, a better result is often achieved just with the wave grid displayed. 
 
This function is only available in the Perspective window with rendering switched on. 
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Measurements 

This command turns of the display of the half-angle of entrance and deadrise 
measurements. 

  

Render 

Displays a rendered view of the model in the Perspective window (only if a MAXSURF 
model has been loaded). If the free surface has been calculated, it will also be rendered. 
 
Rendering is only available in the Perspective window. 

Data Menu 

The Data menu contains commands for changing the data used to calculate the hull’s 
resistance. 

Units 

The default units to be used for linear dimensions, mass, speed, force and power may be 
selected from the units menu. Changes to the default units will be reflected in the Data, 
Results and Graph windows. Data, with the exception of density, may be entered in non-
default units by adding the appropriate units suffix. 

Coefficients  

Specify options for the calculation of various hull coefficients of form (Block, 
Prismatic, Waterplane, etc. coefficients). 

Frame of Reference 

Allows the user to change the draft at which calculations are performed. 

Windows Menu 

The Windows menu allows you to arrange and make any window selected from the 
menu the active window. 

Cascade 

Displays all the windows behind the active windows. 

Tile Horizontal 

Layout all visible windows across the screen. 

Tile Vertical 

Layout all visible windows down the screen. 

Arrange Icons 

Rearranges the icons of any iconised window so that they are collected together at the 
bottom of the MAXSURF Resistance program window. 
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Data  

Brings up the data window. 

Results 

Brings up the Results window. 

Perspective 

Brings up the Perspective window. 

Plan 

Brings up the Plan window. 

Profile 

Brings up the Profile window. 

Body Plan 

Brings up the Body Plan window. 

Graph 

Brings up the graph window. See the Results Graph on page 18. 

Help Menu 

Provides access to Resistance help and other resources. 

Resistance Help 

Display the Resistance help manual. 

Resistance Automation Reference 

Display the Resistance Automation reference help manual. 

Online Support 

Provides access to a wide range of support resources available on the internet. You must 
have internet access to access this functionality. 

Service Request Manager 

Submit and manage your technical support requests with Bentley Systems. You must 
have internet access to access this functionality. 

Check for Updates 

Provides access to our website with the most recent version listed. You must have 
internet access to access this functionality. 

News 

Display the Bentley Systems Offshore news feed. You must have internet access to 
access this functionality. 

CONNECT Advisor 

Display the Bentley Systems CONNECT Advisor. You must be logged in with the 
CONNECTION Centre to access this functionality. 

Legal Notice  

Display the Bentley Systems Legal Notice. 
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About Resistance 

Displays information about the current version of Resistance you are using and other 
diagnostic information. Use this to obtain version and diagnostic information when 
reporting a problem to the Support Staff at Bentley Systems, Incorporated. 

Bentley Cloud Services Menu 

Provides access to Bentley Cloud Services resources. You must be logged in with the 
CONNECTION Centre to access this functionality. 

Associate Project 

Register the current file you are working on with a CONNECTED Project. 

Disassociate Project 

Unregister the current file you are working on from a CONNECTED Project. 

CONNECTION Centre 

Display your personal CONNECTION Centre web portal in your web browser. 

ProjectWise Projects 

Display the CONNECTED Project in your web browser. 
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Chapter 4 Theoretical Reference 

This chapter contains a list of terms and abbreviations used in this manual, and provides 
a literature list for all the resistance prediction methods used in MAXSURF Resistance. 

 Glossary 

 Bibliography 

Glossary 

This glossary describes the key words and abbreviations used in this manual. 

Half Angle of entrance 

The angle measured in the plane of the water plane, between the hull and the centreline.  

Appendage Area 

The wetted area of appendages, used to calculate appendage drag. Set this to zero to 
ignore appendage resistance. 

Appendage Length, nominal 

A nominal length used to calculate the Reynolds Number of the appendages and hence 
the appropriate skin friction coefficient 

Appendage Factor 

A factor for estimating the resistance due to the drag on appendages. Expected values 
range from 1.0 to 3.0. 

Beam 

The maximum submerged width of the hull. 

Bulb Height from Keel 

The distance from the keel line, to the transverse centre of area of the bulb section on 
the waterline at the stem. 

 

Bulb Transverse Area 

The transverse sectional area of the bulb (if any) measured on the waterline at the stem. 

Correlation Allowance 

A factor for accounting for variations between model tests and full-scale trials.  
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Deadrise at 50% Lwl 

The angle measured in the section plane between the hull and the horizontal, as 
measured at midships. 

 

Density, Air 

The air density, at the appropriate ambient temperature. The default value is 1.293 

kg/m^3 for air at 15C. 

Density, Sea 

The sea density, at the appropriate ambient temperature and salinity. The ITTC 1967 

value, for salt water (3.5% salinity) at 15C., of 1025.9 kg/m^3 is given as the default. 

Displaced Volume 

The volume of seawater displaced by the hull. 

Draft 

The maximum submerged depth of the hull. Sometimes also referred to as “draft”. 

Draft at FP 

The draft at the fore perpendicular. This value can be left at zero, whereupon 
MAXSURF Resistance will assume it is the same as the value for the ‘draft’ item. 

Drag Coefficient 

The coefficient of drag for calculation of wind resistance. Expected values would be in 
the range of 0.8 - 1.2. 

Efficiency 

The efficiency used to calculate the ship’s power from its resistance.  

 

Frontal Area 

The area of the vessel above the waterline, when viewed from the front. Set to zero to 
ignore wind resistance. 

Froude Number 

A dimensionless speed measurement:  
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Length, L, is typically used, but may be inappropriate for some measurements, such as 
for a planing hull, where the waterline length varies with speed. In such circumstances, 
beam may be substituted for length, as may draft etc. 

Kinematic Viscosity 

The kinematic viscosity of sea water. The ITTC 1967 value, for salt water (3.5% 

salinity) at 15C., of 1.18831x10-6 m^2/s is given as the default. 

LCG from midships 

The distance to the longitudinal centre of gravity, measured from midships. Note that 
this distance is positive forward. That is, an LCG 1.5m aft of midships will be entered as 
-1.5. 

Length / Lwl 

The length of the hull, measured on the waterline. 

Maximum Sectional Area 

The largest submerged sectional area of the hull, measured when the vessel is at rest. 

Prismatic Coefficient 

A measure of the extent to which the submerged volume of a hull fills the prism defined 
by the submerged length, multiplied by the area of the largest transverse section.  

 

Transom Area 

The submerged sectional area of the transom, measured when the vessel is at rest. 

Transom Beam 

The maximum submerged width of the transom. 

Transom Draft 

The maximum submerged depth of the transom. 

Water plane Area Coefficient 

A measure of the extent to which the area of the water plane fills the rectangle defined 
by the length * beam.  

  

Wetted Area 

The submerged surface area of the hull. For the slender body method, the wetted area is 
used to calculate the Friction and Viscous resistance coefficients only; the wave 
resistance is calculated directly from the surface model. 
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The wetted area is also used to calculate the resistance coefficients displayed in the 
Graph window. 

Volume Froude Number 

A dimensionless speed measurement based on the cube-root of the displaced volume. 
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Appendix A Demonstration Version 

It should be noted that the demonstration version of MAXSURF Resistance is locked to 
two sample models: 
 
1. The MAXSURF Resistance Sample_Workboat.msd design this model will 

automatically open on starting the demonstration version of MAXSURF Resistance. 
It is saved in; 
C:\Program Files\MAXSURF Demo\Sample Designs 

 
2. The MORCYacht_1Surface.msd design this is saved in; 
C:\Program Files\MAXSURF Demo\Sample Designs\SailingYachts 
 
The MAXSURF Resistance input Data may be changed within +/-10% of the values of 
the sample designs. If data is changed beyond this limit a warning will be given and the 
resistance will not be predicted and “calc.” will be displayed in the Results table: 
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Appendix B Applicability 

Since the algorithms are designed for specific hull types, they will be most accurate 
when certain conditions are satisfied. These conditions are:  

 Hullshape 

 Speed 

 Dimensions 

Hullshape 

The hullshape is very important in determining whether a particular method is 
applicable to a particular design. A thorough knowledge of the resistance prediction 
method is required. See the Bibliography section on page 50 to find the relevant 
documents on each of the methods available in MAXSURF Resistance.  

Speed 

The resistance prediction algorithms are useful only within certain speed ranges; these 
limits are: 
 

Algorithm: Low - speed limit High - speed limit 

Savitsky (pre-planing) Fnv = 1.0 Fnv = 2.0 

Savitsky (planing) Fnb = 1.0 None, see note below 

Blount and Fox Fnv = 1.0 None, see note below 

Lahtiharju (round 
bilge) 

Fnv = 1.5 Fnv = 3.8 

Lahtiharju (hard chine) Fnv = 1.5 Fnv = 5.0 

Wyman 0.0 depends on “DL ratio” 

Holtrop 0.0 FnL = 0.80 

Van Oortmerssen 0.0 FnL = 0.50 

Series 60 Fnv = 0.282 Fnv = 0.677 

Delft 0.0 FnL = 0.75 

Compton FnL = 0.1 FnL = 0.6 

Fung 

KR Barge 

FnL = 0.134 

0.0 

FnL = 0.908 

FnL = 0.50 

Slender Body 0.0 Up to FnL ≈ 1.0 depending on 

slenderness ratio 

 
For some algorithms, MAXSURF Resistance will calculate the resistance only for 
speeds within the limits indicated above. For the other algorithms, MAXSURF 
Resistance will calculate the resistance for any speed. The user should be aware that the 
accuracy of the algorithms is expected to decrease beyond the limits outlined above. 
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Gerr (2008) gives this information regarding the applicable speed range for the Wyman 
method: “The Wyman speed formula offers exceptional results at SL ratios over 2 and 
fairly good results at SL ratios under 2”  

where SL is given by:
ne[ft]on waterlilength 

speed[kn]
SL ; 

and SL is related to Froude number by Fn = 0.2976 SL 
 
Note regarding speed ranges. Some of the formulae (Savitsky planing, Lahtiharju and 
Holtrop) are able to calculate the vessel resistance for any speed. However, the 
regression equations were derived from resistance data within specified speed ranges 
and these are noted in the table above. The Savitsky (planing) formula (and hence 
Blount and Fox method) was derived from theory based on the planing behaviour of a 
prismatic hull; whilst there is no theoretical upper speed limit, results for speeds above 
approximately Fnv = 6.0 to 7.0 should be treated with caution. 

 
Fnb - Beam Froude number 
Fnv - Volume Froude number 

FnL - Length Froude number, see Glossary for definition of these Froude numbers. 

Dimensions 

The resistance prediction algorithms are useful only within certain limits of hull 
dimension. These limits are: 
 

Algorithm:  Requirement: 

Savitsky 3.07 < L/V1/3 < 12.4 

(pre-planing) 3.7 < ie < 28.6 

 2.52 < L/B < 18.26 

 1.7 < B/T < 9.8 

 0 < At/Ax < 1 

 -6.56% < LCG/L < 0.3% 

      

Blount and Fox   LCGbf/Lcp < 0.46 

      

Lahtiharju 4.47 < L/V1/3 < 8.30 

(Round Bilge) 0.68 < B3/V < 7.76 

 3.33 < L/B < 8.21 

 1.72 < B/T < 10.21 

 0.16 < At/Ax < 0.82 

 0.57 < Cm < 0.89 

      

Lahtiharju 4.49 < L/V1/3 < 6.81 

(Hard Chine) 2.73 < L/B < 5.43 

 3.75 < B/T < 7.54 

 0.43 < At/Ax < 0.995 

      

Holtrop 0.55 < Cp < 0.85 

 3.9 < L/B < 15 
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Algorithm:  Requirement: 

 2.1 < B/T < 4.0 

      

      

van 

Oortmerssen 

8 < L < 80 

 3 < L/B < 6.2 

 0.5 < Cp < 0.73 

 -8% < LCG/L < 2.8% 

 5 < V < 3000 

 1.9 < B/T < 4.0 

 0.70 < Cm < 0.97 

 10 < ie < 46 

      

Series 60 0.6 < Cb < 0.8 

 5.5 < L/B < 8.5 

 2.5 < B/T < 3.5 

 -2.48% < LCB < 3.51% 

      

Delft 2.76 < L/B < 5.00 

 2.46 < B/T < 19.32 

 4.34 < L/V1/3 < 8.50 

 -6.0% < LCB < 0.0% 

 0.52 < Cp < 0.60 

      

Compton      

 -0.13 < LCG/L < -0.02 

 4.0 < L/B < 5.2 

 0.00368 < V/L^3 < 0.00525 

      

Fung      

 0.00057 < V/L^3 < 0.01257 

 1.696 < B/T < 10.204 

 0.526 < Cp < 0.774 

 0.556 < Cx < 0.994 

 14.324o < ie < 23.673o 

 2.52 < L/B < 17.935 

 0.662 < Cwp < 0.841 

      

Slender Body      

 ≈ 4 or 51 < L/V1/3 < no limit 

 

                                                      
1 The minimum slenderness ratio to which the slender body method can be applied depends on the Froude 
number at which the resistance is being evaluated. As the Froude number is reduced, the minimum slenderness 
ratio to which the method can be applied is also reduced. As a rough guide, at a Froude number of unity, the 
minimum slenderness ratio would be between approximately 7.5 and 8.0. If the Froude number were reduced to 
0.2, then the method could be applied to slenderness ratios as low as 4.0. 
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Where: 

L Length on the waterline 

Lcp Projected length of chine. (onto longitudinal axis of 
vessel). 

B Beam on the waterline 

T Draft of hull 

At Transom sectional area 

Ax Maximum sectional area 

V Displaced volume 

Cm Midship sectional area coefficient 

Cp Prismatic coefficient 

Cwp Water plane area coefficient  

Cx Maximum sectional area coefficient 

ie Half angle of entrance 

LCB Longitudinal centre of buoyancy, measured from 
midships, positive is forward. 

LCG Longitudinal centre of gravity, measured from  

Midships, positive is forward. 

LCGbf* LCG for Blount Fox method measured from the transom 

Deadrise Mean deadrise, or deadrise at 50% Lwl. 

wsa Wetted area of hull. 

Bt Transom beam at waterline 

Tt Transom draft 

Abulb Bulb transverse area. 

 
* Even though the Blount and Fox method specifies using LCG from transom in the 
original paper the user still enters the LCG relative to the midships (or Resistance 
calculates it) in MAXSURF Resistance.  When the Blount and Fox calculations are 
performed internally the LCG relative to the transom is calculated and used. 
 
MAXSURF Resistance will allow calculations beyond these limits; however, the user 
should be aware that the accuracy of the algorithms is expected to decrease beyond the 
limits outlined above. In some cases, the algorithm may become very sensitive to 
parameters outside the specified range.
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Appendix C Slender Body Method 

In this appendix the results of the slender body (thin ship) resistance prediction method 
have been compared against model test data for the following hull forms: 

 Wigley hull 

 NPL round-bilge 

Wigley hull  

Results for the simple Wigley hull form are given below. Here results are compared with 
two theoretical methods Insel (1990) and Michlet as well as experimental results from 
Insel (1990). MAXSURF Resistance can be seen to be in close agreement with the other 
two analytical methods. Although there is a reasonable amount of scatter in the 
experimental results, it appears that the theoretical methods tend to over-predict the 
wave resistance. In the case of the experiments, the model was held fixed in trim and 
sinkage, i.e. the model was kept at the datum waterline. 
 
Wigley parabolic hull parameters: 
L/B 10.0 
B/T 1.6 
CB 0.44 
CP 0.44 
CM 0.44 
WSA/L2 0.1488 
 
Monohull: 

 

Wigley hull bodyplan 
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Comparison of results for Wigley hull 

Catamaran: centreline separation / length = 0.2 
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Comparison of results for Wigley catamaran 

Trimaran: ama half main hull dimensions 
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Comparison of results for Wigley trimaran 

NPL round-bilge 

The following graph shows a comparison between results from MAXSURF Resistance, 
other theoretical methods and experimental results for a transom-sterned hullform. The 
model is a stretched NPL round-bilge form. For transom-sterned hulls, MAXSURF 
Resistance adds a “virtual appendage” which models the air-gap behind the transom 
when the water releases cleanly from the transom edge (high-speed condition) and the 
turbulent viscous wake behind the transom at slow speed (low speed condition) – this 
method is described in detail in Couser et al (1996). For these experimental results the 
model was free to sink and trim; the theoretical results of Couser et al (1996) included 
the actual running trim and sinkage as measured during the experiments and hence the 
very close agreement with the experimental results. The results for MAXSURF 
Resistance use a fixed waterline, since, in general, the trim and sinkage condition at 
each speed is not known. The results from MAXSURF Resistance show good agreement 
with the experimental results, particularly when the transom is clearly in the high or low 
speed condition; in the transition condition, around Froude number = 0.5, MAXSURF 
Resistance under-predicts the resistance. 
 
NPL round bilge, mode 4a (Couser et al 1996 notation) hull parameters 
L/B 10.4 
B/T 1.5 
CB 0.397 
CP 0.693 
CM 0.565 
WSA/L2 0.1359 
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NPL (model 4a) hull bodyplan 

Monohull: 

 

Comparison of results for NPL (model 4a) hull - monohull 
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Catamaran: centreline separation / length = 0.2 

 

Comparison of results for NPL (model 4a) - catamaran S/L = 0.2 
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